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Expt 

No. 

1 

SIMPLE CONICAL, CYLINDRICAL AND 

PLANNER PROJECTION FOR A REDUCED 

EARTH (2 TO 4CM REDUCED EARTH) – 

ASPECT AND SECANT DEMO 

Date of 

Expt: 

 

Aim 

To demonstrate and understand the principles of simple conical, cylindrical, and planar 

projections using a reduced earth model (2–4 cm diameter) and to reconstruct the 3D surface 

mathematically onto a 2D plane, illustrating various aspects (normal, transverse, oblique) and 

the concept of secant projections. 

Materials Required 

1. Reduced earth model (2–4 cm diameter sphere). 

2. Transparent sheets or plain paper for projection surfaces. 

3. Markers or pens for drawing projections. 

4. A light source (point source or parallel rays). 

5. Scissors and tape for shaping paper into cones, cylinders, or planar surfaces. 

6. Ruler and compass for precise drawing. 

7. Graph paper for plotting observations. 

8. Calculator or software (e.g., Python, Excel) for mathematical projection calculations. 

Theory 

1. Map Projections: 

o A map projection transforms the 3D surface of a sphere or ellipsoid into a 2D 

plane. 

o Types of projections include cylindrical, conical, and planar (azimuthal). 

2. Projection Aspects: 

o Normal Aspect: The projection surface is aligned with the earth's axis. 

o Transverse Aspect: The projection surface is perpendicular to the axis. 

o Oblique Aspect: The projection surface is neither normal nor transverse but at 

an angle. 

3. Secant Projection: 

o The projection surface intersects the sphere along one or more standard 

parallels, reducing distortion between these parallels. 
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4. Applications: 

o Cylindrical projections are useful for navigation (e.g., Mercator). 

o Conical projections suit mid-latitude maps. 

o Planar projections are used for polar maps. 

Procedure 

A. Using the Reduced Earth Model 

1. Cylindrical Projection 

 Setup: Wrap a transparent sheet or plain paper around the reduced earth model to 

form a cylinder, ensuring it touches the equator. 

 Mark Features: Trace the equator, prime meridian, and other meridians using a 

marker. Use a light source to project additional features onto the cylinder. 

 Unwrap and Draw: Flatten the cylinder and draw the equator as a straight line, with 

vertical lines for meridians and curved lines for latitudes. 

2. Conical Projection 

 Setup: Form a cone with the transparent sheet and align its vertex above the pole, 

touching one (tangent) or two (secant) standard parallels. 

 Mark Features: Use the light source to project the reduced earth's features onto the 

cone. Trace parallels (as arcs) and meridians (as radiating lines). 

 Unfold and Draw: Flatten the cone into a fan shape. Draw arcs for parallels and 

radiating lines for meridians, ensuring proper spacing. 

3. Planar (Azimuthal) Projection 

 Setup: Place a transparent sheet tangentially to the reduced earth at a specific point 

(e.g., pole or equator). 

 Mark Features: Use a light source to project the features of the reduced earth onto 

the sheet. Trace the outlines of the projections. 

 Draw on Paper: Draw concentric circles for parallels and radial lines for meridians. 

B. Mathematical Reconstruction of the 3D Surface 

1. Coordinate System: 

o Represent points on the 3D surface using spherical coordinates: latitude 

(ϕ\phiϕ) and longitude (λ\lambdaλ). 

2. Choose Projection Type: 

o Cylindrical, conical, or planar, depending on the requirements. 
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3. Mathematical Equations: 

o Cylindrical Projection: x=R⋅λ,y=R⋅ϕx = R \cdot \lambda, \quad y = R \cdot 

\phix=R⋅λ,y=R⋅ϕ 

o Conical Projection (Tangent Case): x=R⋅(λ−λ0)⋅cos⁡(ϕ1),y=R⋅ϕx = R \cdot 

(\lambda - \lambda_0) \cdot \cos(\phi_1), \quad y = R \cdot \phix=R⋅(λ−λ0

)⋅cos(ϕ1),y=R⋅ϕ 

o Planar Projection (Polar Aspect): x=R⋅cos⁡(ϕ)⋅sin⁡(λ),y=R⋅sin⁡(ϕ)x = R 

\cdot \cos(\phi) \cdot \sin(\lambda), \quad y = R \cdot 

\sin(\phi)x=R⋅cos(ϕ)⋅sin(λ),y=R⋅sin(ϕ) 

4. Grid Transformation: 

o Divide the surface into a grid of latitude and longitude. 

o Calculate x,yx, yx,y for each grid point using the selected projection formula. 

5. Plot the Projections: 

o Plot the calculated x,yx, yx,y points on graph paper to reconstruct the 2D map. 

C. Demonstrating Aspects 

1. Normal Aspect: Align the projection surface along the earth's axis. 

2. Transverse Aspect: Orient the surface perpendicular to the axis. 

3. Oblique Aspect: Tilt the surface at an angle relative to the axis. 

Observation 

Projection 

Type 

Aspect Characteristics 

Observed 

Distortions Noted 

Cylindrical Normal True equator, distorted 

poles 

Extreme distortion near poles 

 Transverse Accurate central meridian Distorted edges 

 Oblique Angled features preserved Uneven distortion 

Conical Normal True along standard 

parallels 

Distortion increases away from 

parallels 

 Secant Reduced distortion Distortion minimized near 

parallels 

Planar Normal True at point of tangency Radial distortion increases 

outward 

 

Inference 

1. Cylindrical projections are suitable for equatorial regions but distort polar areas. 
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2. Conical projections work well for mid-latitudes and minimize distortion along 

standard parallels. 

3. Planar projections are ideal for mapping polar regions but show increasing distortion 

further from the point of tangency. 

4. Secant projections reduce distortion within the region of intersection. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Result 

The experiment successfully demonstrated the principles of cylindrical, conical, and planar 

projections, their aspects, and the effects of secant intersections. Mathematical reconstruction 

further validated the 3D-to-2D mapping process. 
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Expt 

No. 

2 

GRADED SYMBOLIZATION AND ISOPLETH 

/ CHOROPLETH MAP 

Date of 

Expt: 

 

Aim 

To understand and create graded symbolization and isopleth/choropleth maps, representing 

quantitative data spatially, and analyze their applications in cartography. 

Materials Required 

1. Base map of the study area (with administrative boundaries, if required). 

2. Quantitative data related to the study area (e.g., population density, rainfall, 

temperature). 

3. Coloured pencils or markers for shading. 

4. Compass and ruler for drawing proportional symbols. 

5. Graph paper or tracing paper (optional). 

6. Calculator or software (e.g., Excel, QGIS) for data processing. 

Theory 

1. Graded Symbolization: 

o Represents quantitative data using symbols of varying sizes (e.g., circles, 

squares, bars). 

o Symbol size is proportional to the data magnitude, allowing easy visual 

comparison. 

2. Isopleth Map: 

o Uses continuous lines (isolines) to represent data of uniform value, such as 

temperature (isotherms) or elevation (contours). 

o Suitable for continuous phenomena. 

3. Choropleth Map: 

o Represents data using varying shades or patterns within defined areas (e.g., 

districts, states). 

o Shades indicate intensity or density of the phenomenon. 

4. Applications: 

o Graded symbols: Population distribution, resource allocation. 

o Isopleth maps: Meteorological and geological studies. 

o Choropleth maps: Socio-economic data visualization. 
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Procedure 

A. Graded Symbolization 

1. Prepare the Base Map: 

o Mark the locations (e.g., cities, districts) where data will be represented. 

2. Data Processing: 

o Organize data into ranges (e.g., small, medium, large values). 

o Decide on a proportional scale for symbols. Example: 1 cm2=1000 people1 \, 

\text{cm}^2 = 1000 \, \text{people}1cm2=1000people. 

3. Draw Symbols: 

o For each location, draw a symbol (circle, square, or bar) proportional to the 

data value. 

o Ensure symbols do not overlap excessively; adjust positions slightly if needed. 

4. Legend Creation: 

o Create a legend showing the relationship between symbol size and data value. 

B. Isopleth Map 

1. Data Collection and Base Map: 

o Collect continuous data (e.g., temperature, rainfall) for multiple points in the 

area. 

o Mark data points on the base map. 

2. Interpolation: 

o Use interpolation techniques (e.g., linear interpolation) to estimate values 

between data points. 

3. Draw Isolines: 

o Connect points of equal value to create isolines (e.g., every 5°C). 

o Ensure smooth, logical curves without abrupt changes. 

4. Legend Creation: 

o Add a legend indicating the value of each isoline. 

C. Choropleth Map 

1. Data Processing: 

o Group quantitative data into classes (e.g., low, medium, high). Use statistical 

methods like equal intervals or natural breaks. 

2. Shade Areas: 
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o Assign a shade or pattern to each class. Darker shades typically represent 

higher values. 

o Color each area on the base map according to its data class. 

3. Legend Creation: 

o Add a legend with shades/patterns and corresponding data ranges. 

Observation 

Map Type Observation Advantages Limitations 

Graded 

Symbolization 

Symbols clearly show 

data magnitude 

differences. 

Easy to interpret 

relative quantities. 

Overlapping symbols 

may cause clutter. 

Isopleth Map Smooth isolines depict 

continuous data variation. 

Effective for 

continuous 

phenomena. 

Interpolation may 

lead to inaccuracies. 

Choropleth Map Shading indicates 

intensity in defined areas. 

Simple to create and 

interpret. 

Assumes uniform data 

within regions. 

Inference 

1. Graded symbolization effectively visualizes quantitative data differences at discrete 

points but requires careful symbol placement. 

2. Isopleth maps are ideal for representing continuous phenomena like temperature but 

depend heavily on interpolation accuracy. 

3. Choropleth maps provide a clear representation of area-based data, though they may 

oversimplify data distribution within regions. 

 

 

 

 

 

 

 

Result 

The experiment successfully demonstrated the creation and application of graded 

symbolization, isopleth, and choropleth maps. Each map type effectively visualized 

quantitative data, with distinct strengths and limitations. 
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Expt 

No. 

3 

MAP COMPILATION AND DESIGN 
Date of 

Expt: 

 

Aim 

To understand the process of map compilation and design, and create a thematic map that 

effectively represents spatial data for a specific purpose. 

Materials Required 

1. Base map of the study area (physical or digital). 

2. Thematic data related to the area (e.g., population density, land use, transportation). 

3. Drafting tools (pencil, eraser, ruler, compass). 

4. Colored pencils or markers for highlighting features. 

5. Transparent sheets or tracing paper for overlays. 

6. Graph paper or software (e.g., QGIS, ArcGIS, or Illustrator) for digital design. 

7. A computer for data processing and digital cartography (if applicable). 

8. Reference materials (e.g., atlases, topographic maps). 

Theory 

1. Map Compilation: 

o Definition: The process of collecting, selecting, and synthesizing geographical 

data from various sources into a coherent and accurate map. 

o Steps: 

 Data collection from reliable sources (e.g., surveys, satellite imagery). 

 Data selection based on the map’s purpose. 

 Generalization to simplify details while retaining essential information. 

2. Map Design: 

o Definition: The art and science of creating maps that effectively communicate 

spatial information. 

o Elements of Map Design: 

 Title: Clearly indicates the purpose of the map. 

 Legend: Explains symbols and colors used on the map. 

 Scale: Represents the relationship between distances on the map and 

the real world. 

 Orientation: Indicates north using an arrow or compass rose. 
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 Labels: Provides names or descriptions of map features. 

3. Importance of Map Compilation and Design: 

o Ensures accuracy, clarity, and visual appeal. 

o Aids decision-making in fields like urban planning, resource management, and 

disaster response. 

Procedure 

A. Map Compilation 

1. Define Purpose: 

o Determine the objective of the map (e.g., population distribution, resource 

mapping). 

2. Collect Data: 

o Gather thematic data and base maps from reliable sources (e.g., census 

records, GIS databases). 

3. Select Data: 

o Choose relevant data layers that align with the map’s purpose. 

4. Generalize Features: 

o Simplify complex features to ensure clarity without losing essential 

information. 

o Combine similar features where necessary. 

5. Verify Data: 

o Cross-check data for accuracy and consistency. 

B. Map Design 

1. Prepare the Base Map: 

o Use a base map that includes key geographical features like boundaries, rivers, 

and roads. 

2. Design Layout: 

o Determine the map’s orientation and size. 

o Allocate space for the title, legend, scale, and other elements. 

3. Symbolization: 

o Assign distinct symbols, colors, or patterns to represent different features or 

data categories. 

o Ensure symbols are intuitive and easily distinguishable. 
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4. Labeling: 

o Add names or descriptions to important features. 

o Use consistent font styles and sizes for readability. 

5. Add Cartographic Elements: 

o Include a title, legend, scale bar, and north arrow. 

6. Review and Refine: 

o Check the map for errors and ensure it meets its intended purpose. 

Observation 

Aspect Observation Challenges Faced 

Data 

Collection 

Reliable data sources are critical. Limited access to detailed data in 

some cases. 

Generalization Simplification ensures clarity. Overgeneralization can omit vital 

details. 

Symbolization Distinct symbols enhance visual 

appeal and understanding. 

Misleading or overlapping symbols 

may confuse users. 

Map Elements Title, legend, scale, and orientation 

improve readability. 

Space allocation for elements is 

critical. 

Inference 

1. Accurate and reliable data is the foundation of a good map. 

2. Map design requires balancing clarity, aesthetics, and functionality. 

3. Proper symbolization and labeling ensure effective communication of spatial 

information. 

4. Incorporating cartographic elements enhances the usability and professional quality of 

the map. 

 

 

 

 

 

Result 

The experiment successfully demonstrated the process of map compilation and design, 

resulting in a thematic map that effectively represents spatial data. The map highlights the 

importance of careful data selection, symbolization, and design principles in cartography.
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Expt 

No. 

4 

DATA INPUT – ONSCREEN DIGITISATION – 

CREATION OF POINT, LINE AND POLYGON 

LAYERS 

Date of 

Expt: 

 

AIM :  

To do Rectification and spatial referencing on the digital map and create polygon, line and 

point features. 

Software used: 

QGIS , ArcGIS 

PROCEDURE : 

 Create a new folder inside your roll number folder and name it as EX4 – copy the 

DGL_line point.JPG in JPEG from shared folder. 

 Open QGIS desktop in QGIS software – select raster option and click on the 

Georeference menu. 

 Spatial referencing is done in Georeferencer. It is available under raster menu or layer 

menu depending on the QGIS version. Open Georeferencer and load the image 

DGL_line point.JPG.Now the image will appear in the Georeference window. 

 Go to the setting option – Select transformation settings and name the output fill in 

which folder it has to be saved and it should be in .tiff format. Also check the option 

[i.e, Load in QGIS when done]  

 Georeferencing is done for assigning Co-ordinates o the known points, check the co-

ordinate reference system selector is in WGS84 [CRS] and EPSG 4326 [Authority ID] 

and select done when completed. 

 Now Zoom to the top of the map and select add point and then click at the center of the 

Co-ordinates. 

 Enter the X and Y Co-ordinates, Here the X- Co-ordinate is longitude and Y- Co-

ordinate is latitude. They are assigned in mentioned format [dd mm ss.ss]. 

 The same procedure is repeated for assigning the other points also. If there is any 

wrong pick up of point, then the point can be deleted with the delete option by 

selection of that particular point. 

 After assigning the reference points rectification is done by clicking start 

Georeferencing option. 

 Check for error at GCP table which is visible at the bottom of the dialog box. The error 

should be minimum so that it shows accurate results. 

 Close Georeference window – Select Raster – Open –The saved modified digital map 

– The rectified and spatially referenced map displays on the main screen of QGIS. 

 The Note the residual error occurred in this experiment. 
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DIGITIZATION OF POLYGON: 

 

 Add the DGL_line point_Modified.tif the rectified output image to QGIS canvas. 

 Click on Menu layer – create layer- New shape file layer and select the type as 

polygon and the co-ordinate reference system should be 4326 WGS 84. 

 Save the layer in EX4 folder as “Block”. 

 Go to settings – Select snapping option and click tick in the layer Blockoption and set 

the mapping unit as pixels and tolerance as 10.00. 

 Also select avoid intersection, Enable topology editing and Enable snapping on 

intersection. 

 Select Block layer in  layers panel 

 Click on toggle editing button and select add feature to draw polygon along the 

boundary lines. 

 Select a point on any boundary line and continuously add points by left clicking along 

the boundary after completing the last point, right click then enter the id of the polygon 

– click ok. 

 Repeat the same procedure to create all the boundary line using toggle button and if 

there is any island polygon then the island polygon is created first then the outer 

polygon. 

 Right click the “Block” layer and click properties and change it transparency/opacity 

under Symbology tab  to 50% and click ok, so that the polygon IDs can be at visible.  

 Errors can be checked using Topology Checker plugin. In topology checker panel click 

settings – select block – add the following rulesi)must not have duplicates, ii)must not 

have gaps, iii)  must not overlap, iv)must not have invalid geometry v) must not have 

multi-part geometries  

 Now, in topology checker panel clickvalidate all button to check error, if there are 

errorscorrect them by re-digitizing. 

 Click Save layer edits button and toggle editing button to switch of editing mode. 

 Digitization is completed for the polygon layer. 

DIGITIZATION OF ROADS: 

 Click Menu layer – create layer – New shape file layer and select the type as line and 

co-ordinates reference system as 4326 WGS 84 and save itin EX4 folder as “Roads”. 

 Go to settings – snapping option in layer – change to advanced and select both road 

and block, mapping units as pixels and tolerance as 5&10 and change to vector data. 

 Click avoid intersection, Enable topology and enable snapping on intersection and 

click ok. 

 Select Roads layer in layers panel   

 Selecttoggle editing button and click add feature and start from the boundary line and 

click – setting – Snapping option – Remove the tick in Block – click ok and continue 

to add points to create line. 
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 Once it reach the end of the line again go to snapping option – select the tick in block – 

to end the line in boundary line. This is make sure the road snap to polygon boundary. 

Right click then enter the id of the road 

 The same procedure is carried out for all the other lines too. 

 Select the toggle editing button and click save the ‘Road’. 

           DIGITIZATION OF RAILWAY LINES: 

 Click Menu layer – create layer – New shape file layer and select the type as line and 

co-ordinates reference system as 4326 WGS 84 and save itin EX4 folder as “Rail”.. 

 Following the same procedure as road is carried out for rail layer also and finally save 

the layer. 

DIGITIZATION OF POINTS [LANDMARKS] : 

 Click Menu layer – create layer – New shape file layer and select the type as line and 

co-ordinates reference system as 4326 WGS 84 and save itin EX4 folder as Point. 

 Click toggle and add feature and add points, give ID number and save.  

 Click toggle again to end editing. 

 

GEOREFERENCING USING ArcGIS: 

 

 ArcMap is used for map preparation and ArcCatlog is used as file manager, import, 

export and conversion. 

 Open ArcCatelog – Right click on DGL_line point.JPG– properties – select spatial 

reference – edit. 

 Set the XY co-ordinates  as Geographic co-ordinates system - world – WGS 1984 – 

click apply and select ok  

 Close ArcCatalog. 

 Open ArcMap  

 Click add data  button and add DGL_line point.JPG,Click yes to pyramids (to zoom 

properly) and inconsistent as ok. 

 Load Georeferencing tool bar if not there. 

 Click add control points – click to enter X&Y co-ordinates and enter the DMS. 

 After giving 2 co-ordinates the image may disappear right click at layer and zoom to 

layer. The image will appear. 

 The same procedure is carried out for all the 4 co-ordinates and the select in 

Georeferencing  -  rectify the image save the file in EX4 in .tiff format and saved.  
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DIGITIZATION AND DATABASE CREATION in ArcGIS: 

 Open ArcCatalog right click EX4 folder – select new- file geodatabase – rename it as 

Dind.gdb. 

 Right click over Dind.gdb again- new – click feature data set and name it as block and 

set co-ordinate reference system as WGS 1984 – select next – and click finish. 

 Right click on the block feature dataset – select new – click feature class,name it 

village, type as polygon and next – next – and select finish. 

 Right click on the block again to create for road, rail and point the above procedure is 

same but the type changes for road and rail as line feature and point as point feature 

and select finish when completed. 

 Close ArcCatalog 

 Open ArcMap and click – add data button and select the saved Dind.gdb and block 

and the DGL_line point image. 

 Switch on Editor and snapping toolbars, if not there 

 Select Block in the table of content. 

 Click Editor- start editing, then click create features button on the editor toolbar. 

Choose snapping option, select snapping toolbar and select snap to sketch. 

 Select create feature – select village – select polygonfrom construction tools at the 

bottom and draw the first one and select auto polygon for all other. 

 For the island polygon draw the outer polygon, select that and using cut polygon tool 

and cut the island polygon alone. 

 The same procedure is carried out for rail and road by selection line for point by 

selecting point. For rail and road the snapping edge must be on. 

 Click save edit in editor toolbar to save the changes and stop editing. 

TOPOLOGY CHECKING in ArcGIS: 

 In ArcCatelog – click the layer – preview – change the geometry to table, the 

number should be minimum for area and perimeter , and no zero value should be 

there. 

 Right click the block select new and select topology and click next – next and 

select village – next – next – add rule – select must not overlap and must not gave 

gaps and select ok – click next and select finish. 

 New topology is created, click yes to validate and click block topology – select 

properties and select generate summary. 

 Note the error polygon  and in ArcMap correct the error 

 Once the error is free delete the topology layer. 

RESULT : 

The Rectification and spatial referencing on the digital map is assigned using 

Georeferencing in QGIS Software and the digital map is completely digitized using 

polygon, line and point feature in QGIS software by means of toggle editing and 

snapping option. 
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Expt 

No. 

5 

PROJECTION, REPROJECTION AND 

COORDINATE TRANSFORMATION OF 

MAPS 

Date of 

Expt: 

 

AIM : 

To change from one system of co – ordinates into another system of co – ordinates ( 

UTM, polyconic ) by means of projection and to calculate area,  perimeter, length and 

to digitize the digital map using ArcGIS software and georeferenced it. 

 

INTRODUCTION : 

 PROJECTIONS : 

Projection are a mathematical transformation that take spherical co-ordinates ( 

latitude and longitude) and transform them to an XY (planner) co-ordinates 

system. This enables you to create a map that accurately shows, distances, area or 

direction. With this information, you can accurately work with the data to 

calculate areas, distances and measure direction. 

 POLYGONIC PROJECTION : 

A map Projection consisting of a composite series of concentric cones each 

of which before being unrolled has been placed over a sphere so as to be tangent 

to a different parallel latitude. 

 UTM ( Universe Transverse Mercator) : 

UTM is a system for assigning co-ordinates to locations on the surface of the 

earth. Like the traditional method of latitude and longitude, it is a horizontal 

position representation, which means it ignores altitude and treats the earth as a 

perfect ellipsoid. However, it differs from global latitude/longitude in that it 

divides earth into 60 zones and projects each to the plane as a basic for its co-

ordinates. 

 GEOREFERENCING : 

Georefrencing means that the interval co-ordinates system of a map or ariel 

photo image can be related to a ground system of geographic co-ordinates. The 

relevant co-ordinates transforms are typically stored within the image file, through 

there are many possible mechanisms for implementing georeferencing. 

 DIGITIZATION : 

Digitizing in GIS is the process of converting geographic data either from a 

hardcopy or a scanned image into vector data by tracing the features. During the 

digitizing process, features from the traced map or image are captured as co-

ordinates in either point, lines or polygone format. 

 RECTIFICATION : 

Image rectification is a transformation process used to project multiple image 

onto a common image surface. It is used to correct a distorted image. 
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Software used: 

QGIS , ArcGIS 

 

REQUIREMENTS : 

 

A system equipped with QGIS and ArcGIS software. 

Digitized shape file obtained from previous experiments. 

Digital line point map. 
 

PROCEDURE : 

PROJECTION OF DIGITAL MAP : 

 

 Create a folder EX5 and copy all the data from the EX4 folder. 

 

 This existing data’s are in degrees. To find the area and perimeter of the map, we need 

to project them. 

 

 In QGIS software open all the layers shape files, block, rail, road and point. 

 

 Go to the block in layer and right click – select save as – and co-ordinate reference 

system as UTM projection [ EPSG : WGS 84 / UTM Zone 44 N] and check format as 

ESRI shape file and finish and save the file name as Block_UTM in EX5 and select 

ok. 

 

 Cary out the same procedure for the road, rail and point, save them as Road_UTM, 

rail_UTM and point_UTM in the EX5 folder.. 

 

 Right click the Block_UTM – Go to attribute table – click toggle editing – click new – 

field and set the name as Block_area and type as Decimal number and length as 15 

and precision as 4 and select ok. 

 

 Open field calculator – click update existing field and remove the tick from new field 

and select the ID as Block_area – search for geometry and click $area (double click) 

and select ok. Note the values. 

 

 Open field calculator and click ne feature and field name as Block_ perimeter and 

change to decimal number and length as 15 and precision as 4 go to geometry and 

select $perimeter (double click) and select ok. Note the values and click toggle again 

to save. 

 

 Right click Rail_UTM and select go to attributes table – toggle editing – click open 

field calculator – new field – set name as rail_length and type as decimal number, 
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length 15 and precision as 4 and select ok and select geometry and $length and select 

ok click toggle again to save and note down the values. 

 

 The same procedure as rail is carried out for Road_UTM and Point_UTM. Where as 

in point there will be no geometry. Note down all the values and select toggle again to 

save. 

 The same way the data can be projected to other projections like polyconic EPSG 

54021 (word polyconic) 

PROJECTION AND ADDING ATTRIBUTES in ArcGIS: 

 From ArcToolBox – select Data Management tools – select Projection and 

Transformation and click Project. 

 The input data is Dind.gdb-Block dataset-village layer  

 The output co-ordinate system as world polyconic projection 

 Ouput feature vill_pc 

 Right click vill_pc and open attribute table, Shape_area and perimeter fields are 

added. 

 Using Add Field, add an ID field of type short integer. Then Editor Start editing 

add id for each polygon.  

 Similarly project road, rail and point feature classes. 

 The same way the data can be projected to other projections like UTM (WGS 84 – 

North WGS 1984 UTM Zone 44 N.) and save as vill_UTM 
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Expt 

No. 

6 

ATTRIBUTE DATA INPUT AND 

MEASUREMENT OF DISTANCE, AREA 

Date of 

Expt: 

 

AIM: 

To add names and other details for the digitized polygon line and point in the attribute table 

using QGIS software and ArcGIS software and to project one system of co-ordinates into 

another system of co-ordinates by means of projection. 

INTRODUCTION: 

1. ATTRIBUTE TABLE : 

 The attribute table function allows to degree an attribute table to symbolize a 

single bond mosaic dataset on raster dataset. 

 Attribute data are character, numeric data, data and time data etc…, 

 The character property (or string) is for text based values as name of the sheet or 

peace character data is not numeric, this calculations can’t be performed. 

 Integer and floating are numerical values. Integer type is further divided into short 

and long integer values short integer store numeric values without fractional 

values for a shorter range than long integer, whereas floating point attributes 

values store numeric values with fractional values. Therefore, floating point 

values are for numeric vales with decimal points. 

 

2. MATERIAL REQUIRED : 

 QGIS Software 

 ArcGIS Software 

 Digitized map 

 

PROCEDURE: 

 Create a folder EX6 and copy all the data from the EX5 folder.  

QGIS: 

1. ADDING ATTRIBUTES IN UTM : 

 Open Block_UTM.shp, Road_UTM.shp, Rail_UTM.shp and Point_UTM.shp in 

QGIS –select properties and select the labels as such show tables with ID. 

 Now right click on the Block_UTM and open attribute table – select toggle editing 

– and select create new file and name as Bname and the type as text and character 

is 20 maximum and select ok. 

 As above add the following fields 

o Name: TPOP   Type: Whole number Length:5 

o Name: TCA Type: integer Length: 4 

o Name: PI Type: text Length: 1 
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 In the respective fields enter the data as per the details available in the image for 

all the polygons.  

 Save edits and toggle editing. 

 Now we can directly go to the properties and view the necessary details by 

selecting the name ID. 

 We can also change the style of the ID and the colour for each one different in 

properties. 

 The same procedure is carried out in rail, road and point by adding name to each 

road and the railway line. 

 Point_UTM also carries out in rail and road UTM function by adding name to 

each road and the railway line. 

 Point UTM also carries out the same procedure by assigning different location 

names. 

 Now, open a new excel file and enter all the data from the DGL image in the excel 

sheet and save the book sheet. 

 

Measurements: 

 Area and perimeter is added to the attribute table in the previous experiment. For 

manual measurement click the dropdown arrow in the measurement tool, select either 

Measure line or Measure area as per the requirement and measure on the map. Click 

minimum three points for area measurement and right click to measure and minimum 

two points for length. Here we can set measuring unit and coordinate systems.  

 

ArcGIS: 

ADDING ATTRIBUTES: 

 Open ArcMap and add projected village poly ie. vill_pc. Right click open 

Attribute table. Select Add field from Table option 

 Enter Name: ID Type: Short Integer, Click Ok 

 Like create the following fields 

o Name: Vill_name, Type : Text, Size: 20 

o Name: Tpop, Type: Short Integer 

o Name: TCA, Type: Short Integer 

o Name: PI, Type Text, Size: 1 

 From ArcMap Editor, Click Start Editing 

 Select a village polygon using selection tool and switch to attribute table. Click on 

show selected records. Now the details of ID, Name, Tpop, TCA and PI can be 

entered.  

 Switch to ArcMap select next village and update the fields. After entering data for 

all the villages, save and stop editing 
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 Similarly, Add ID, Name details for road_pc, rail_pc and point_pc and update the 

values. 

 Add only IDs for UTM projected output 

 

Measurements: 

 Shape_Area and perimeter is added to the attribute table by default. For manual 

measurement click the measurement tool in the Tools Toolbar, this will open 

Measure window. Select line, polygon, etc, as per the requirement and measure on 

the map. Click minimum three points for area measurement and double click to 

measure and minimum two points for length.  

RESULT: 

The attributes are added to the QGIS and in ArcGIS and polyconic projection are done in 

QGIS and UTM and polyconic projection are done in ArcGIS. Measurement methods are also 

practiced.    
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Expt 

No. 

7 

LINKING EXTERNAL DATABASE AND 

TABULAR DATA ANALYSIS USING SQL 

COMMANDS 

Date of 

Expt: 

 

AIM: 

Link the attribute data that is available externally and do queries on attribute.  

INTRODUCTION: 

 ATTRIBUTE QUERIES: 

 To get information familiar with constructing attribute queries in QGIS/ArcGIS 

and presenting the result in the form of map for visualization and analysis 

purpose. 

PROCEDURE: 

Linking external data in QGIS: 

CSV: 

 Create a folder EX7 and copy all the data from the EX6 folder.  

 Open Notepad and type the following in the first line 

o vid, vname, tpop, tca, pi 

o Following the above from next line enter the actual values from the table 

on the image with separated by commas. One entry is enough each id. 

o Save As Name :“data.csv”, Type: All files. (important: enter the name 

within the double “”)  

 Load the Block_UTM layer and data.csv 

 Open the attribute table and delete fields Name, TPOP, TCA and PI and save 

 Right click Block_UTM –> Properties -> Join 

 Click (+) Add new join and Join layer : data.csv, Join Field: vid, Target Field: ID 

click Ok and one more Ok 

 Open attribute tabke of Block_UTM, now the Name, TPOP, TCA and PI fields are 

joined with the Block_UTM layer based on ID. This join is temporary.  

 Can be removed by Right click Block_UTM –> Properties -> Join-> Remove join 

(-) 
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PostgreSQL Database: 

 

 From the Browser panel Right click on PostgreSQL->New Connection and enter the 

following details 

o Name: <your roll number> 

o Host:192.168.5.3 

o Port: 5432 

o Database: scott 

 Under Authentication choose Basic tab. Enter the following 

o User name: scott 

o Password:***** 

o Do not store Username and Password 

 Click on Test connection, On successful  

 Enable the Check box: Also list the tables with no geometry 

 Click Ok to close 

 On PostgreSQL connection expand the newly created <your roll number> 

 Enter user credential to connect database 

 Browse for the table dgl and that to the project 

 Now using the join property join dgl table by  Right click Block_UTM –> Properties -

> Join -> Add Join as did in the previous data.csv step. 

 

QUERIES IN QGIS: 

 As an example there is a need to have a layer from Block_UTM, having TCA 

greater than 500 where the population also more than 1000. To create the layer 

that satisfying above condition we need to query on the tabular data and save the 

result as a layer. 

 Keep any one of the previous join 

 Open attribute table of Block_UTM, click ‘select features using an expression’ 

button, This will open the expression builder window. 

 Expand the Fields and Values under category and double click on TCA to add that 

on expression.  

 Expand the Operators under category and double click > symbol to add that on 

expression. Next to that type 500 as value. 

 Under Operator double click AND operator to add that on expression.  

 After AND add TPOP > 1000 to the expression 

 Click Select Feature at the bottom of the expression widow (other options are add 

to the current selection, remove from the current selection and filter current 

selection) 

 In the attribute table at the bottom select view only selected object the selected 

polygon will be viewed. 

 To save the selected features as a separate layer, switch to QGIS and right click 

Block_UTM,->Export ->Save feature as. Type: ESRI Shape File, Browse to EX7 
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folder and give name as query1.shp and enable save only selected features and 

click Ok 

 By using the expression builder with the combination of operators and selection 

methods, many query layers can be created 

Linking external data in ArcGIS: 

CSV: 

 Open the ArcMap and add vill_UTM , data.csv 

 Right click on vill_UTM->Joins and Relates->Join and choose the values as 

1. ID 

2. data.csv 

3. vid 

o Click ok 

 Open attribute tabke of vill_UTM, now the Name, TPOP, TCA and PI fields are 

joined with the vill_UTM layer based on ID. This join is temporary. 

 Right click on vill_UTM->Joins and Relates->Join and choose Remove Join(s) 

PostgreSQL Database: 

 Open ArcCatalog 

 Click Add Database Connection and in the opened window give the following 

details to create a connection to PostgreSQL database 

o Database Platform: PostgreSQL 

o Instance: 192.168.5.3 

o Authentication Type: Database Authentication 

o Username:scott 

o Password:***** 

o Database:scott 

o Do not save password 

 Open ArcMap and add vill_UTM  

 Click AddData and open the Database connection. Give the username and 

password 

 Select dgl table to add ArcMap 

 Right click on vill_UTM->Joins and Relates->Join and choose the values as 

4. ID 

5. scott.public.dgl 

6. vid 

o Click ok 

 Open attribute tabke of vill_UTM, now the Name, TPOP, TCA and PI fields are 

joined with the vill_UTM layer based on ID. This join is temporary. 

 Right click on vill_UTM->Joins and Relates->Join and choose Remove Join(s) 

 

 

 



25 
 

RESULT:  

 Linking the data available externally as .csv or form PostgreSQL is practiced and the 

different type queries were executed in QGIS, ArcGIS 
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Expt 

No. 

8 

GENERATING GRAPHS, CHARTS AND 

DIAGRAMS FROM TABULAR DATA 

Date of 

Expt: 

 

Aim 

To generate graphs, charts, and diagrams from tabular data for effective visualization and 

spatial analysis. 

Software Required 

 ArcGIS (version 10.x or higher). 

 QGIS (version 3.x or higher). 

 Tabular data in formats such as CSV, Excel, or attribute tables (e.g., population 

statistics, land-use data, rainfall data). 

 A shapefile or geospatial dataset (optional for spatial visualizations). 

Theory 

 Graphs and charts allow the representation of data trends, comparisons, and 

distributions. 

 Diagrams combine spatial and attribute data for meaningful analysis. 

 ArcGIS provides the Chart View and Symbology tools to generate graphs such as bar 

charts, pie charts, and histograms. 

 The Geostatistical Analyst and Spatial Analyst extensions can integrate tabular data 

with spatial features. 

 QGIS includes the DataPlotly Plugin, Diagrams, and Symbology options to create 

visualizations. 

 Built-in tools enable advanced customization and export options. 

Procedure 

 Create a folder EX8 and copy all the data from the EX6 folder 

ArcGIS 

 Open ArcMap and add vill_pc layer  

 Set symbology based on TCA unique values 

 Open attribute table of the vill_pc layer and select Create Graph. 

 In the wizard set the following 

o Graph Type: pie 

o Layer: vill_pc 

o Value field: TCA 

o Select Add to legend and show border 

 Click Next 

o Select All feature 

o Title: TCA 

o Select Graph Legend 

 Click Finish 
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The Graph is generated. Right click in the chart area and select properties to change any 

setting for further tuning or changing chart type etc. 

Finally Right click in the chart area and export as JPEG format. 

QGIS 

 Open QGIS Desktop  

 Install DataPlotly plugin if not available in QGIS 

 Load the Block_UTM layer 

 Click Show the DataPlotly Dock button 

 Choose Pichart in Plot Type 

 Layer as Block_UTM 

 Select TCA for Group field and Y field 

 Click Create Plot, The Pi chart is now display on the window 

 From layout option Title, Font style can be modified 

 Chart can be export as image or html. 

 Other type of charts can be created 

 Diagram such as Pi chart/Bar  chart can be generated  and display on the map. Right 

click on Block_UTM->Properties->Diagrams, Choose the filed  TCA from Available 

attributes  and move to Assigned attributes pane. 

 

 

 

 

 

 

Result 

The experiment demonstrated the successful creation of graphs, charts, and diagrams from 

tabular data using ArcGIS and QGIS. 
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Expt 

No. 

9 

DATA CONVERSION – VECTOR TO RASTER 

AND RASTER TO VECTOR 

Date of 

Expt: 

 

AIM:   

To convert data from vector to raster and vice versa in ArcGIS. 

 

SOFTWARE USED: 

ArcGIS 

 

PROCEDURE: 

 

 Create a folder EX9 and copy all the data from the EX6 folder 

 Open ArcMap and add vill_pc 

Vector to Raster 

 Open Arc tool – Conversion tool – To Raster –Polygon to Raster with following 

values 

o in_features: vill_pc 

o field: ID 

o cell_size:  34 ;(here keep default) 

o out_raster:  Block_V2R34 ;(34 is the cellsize) 

o Click Ok 

 Using identify tool select any raster polygon (example ID 12) on Block_V2R34 and 

note the count. The area can be calculated by count x cell_size^2. Note this value. 

Raster to Vector 

 Open Arc tool – Conversion tool – From Raster – Raster to Polygon with following 

values 

o in_raster: Block_V2R34 

o field: value 

o select: simplify polygon 

o out_raster:  Block_R2V34 

o Click Ok 

 Using identify tool select same polygon (example ID 12) on Block_R2V34 and note 

the area.  

 Repeat  the above vector to raster and  raster to vector for the cell sizes 24 and 44  

 All the three area values of ID 12 ie. before conversion on vill_pc, after convert to 

raster on Block_V2R34 and back to vector on Block_R2V34 can be noted in all the 

three cell sizes 24, 34 and 44 in a table form. Write your inference. 
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Vill_pc LAYER: 

Id Cell 

size 

Area 

before 

conversion 

Vector to raster – 

cell count 

Vector to raster 

–shape area (m²) 

Raster to vector 

(shape area) m² 

      

 

 Do the conversions on road_pc 

 Open Arc tool – Conversion tool – To Raster –Polyline to Raster 

 Open Arc tool – Conversion tool – From Raster – Raster to Polyline 

            RESULT: 

The data was converted from vector format to raster and raster to vector. 
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Expt 

No. 

10 

MAP JOINING, EDGE MATCHING AND 

LAYOUT DESIGN 

Date of 

Expt: 

 

Aim 

To perform map joining, edge matching, and layout design in ArcGIS and QGIS software for 

seamless integration of spatial data and effective map visualization. 

Software Required 

 ArcGIS (10.x or higher). 

 QGIS (3.x or higher). 

 Multiple map tiles or datasets with adjacent boundaries (e.g., shapefiles, 

geodatabases, or raster datasets). 

 Attribute data for thematic mapping (optional). 

Theory 

1. Map Joining: 

o Combines adjacent map tiles or datasets into a single seamless layer. 

o Ensures uniformity in spatial extent and projection. 

2. Edge Matching: 

o Corrects misalignments or gaps along the edges of adjoining datasets. 

o Ensures that features like roads, rivers, or boundaries align perfectly. 

3. Layout Design: 

o The process of arranging map elements (title, legend, scale bar, etc.) in a 

professional and visually appealing way. 

o Important for communicating spatial information effectively. 

Procedure 

 Create a folder EX10 and copy all the data from the EX6 folder. Use UTM projected 

layers for Map Layout 

A. Map Joining 

In ArcGIS: 

 Load the map tiles or datasets into ArcMap. 

 Ensure all datasets have the same projection using the Project tool in the Data 

Management Toolbox. 

 Use the Merge tool in the Toolbox (Data Management > General). 

 Input the datasets to be merged and specify the output file location. 

 Check the merged dataset for seamless integration of features. 
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In QGIS: 

 Add datasets to the QGIS workspace using Layer > Add Layer > Add Vector Layer. 

 Use the Merge Vector Layers tool (Processing > Toolbox > Vector General). 

 Input the datasets to be merged and set the output location. 

 Ensure the merged dataset is displayed correctly. 

B. Edge Matching 

In ArcGIS: 

 Use the Edge Matching tool in the Editing Toolbox. 

 Select the reference and source layers. 

 Manually edit features using the Edit Tool to match the edges. 

 Use snapping settings to ensure precise alignment. 

 Save the corrected dataset to avoid data loss. 

In QGIS: 

 Activate snapping from the Snapping Options menu. 

 Use the Vertex Tool to manually align misaligned edges. 

 Enable Avoid Overlaps in the snapping options to ensure consistent topology. 

 Save the edited layer to finalize the corrections. 

C. Layout Design 

In ArcGIS: 

 Go to View > Layout View to design the map layout. 

 Insert title, legend, scale bar, north arrow, and other elements using the Insert menu. 

 Arrange elements for a balanced and professional appearance. 

 Use the Data Frame Properties to customize the map extent and scale. 

 Export the layout as a PDF or image file using File > Export Map. 

In QGIS: 

 Go to Project > New Print Layout to create a layout. 

 Add the map, title, legend, scale bar, and north arrow using the toolbar. 

 Adjust fonts, colors, and positions for a professional design. 

 Export the layout as a PDF or image file using the Export as Image or Export as 

PDF options. 

 

 

Result 

The experiment successfully demonstrated map joining, edge matching, and layout design in 

ArcGIS and QGIS software, resulting in seamless spatial datasets and professional map 

layouts. 


